Aim and purpose
The aim of this module is to introduce participants to a wide range of tools and technologies appropriate for their role and projects.

Learning outcomes
On completion of this module a learner should:
1. identify the concepts and features of ICT available for construction projects;
2. identify various ICT applications;
3. assess and review the business benefits of ICT;
4. understand the potential benefits of emerging technologies and their impact;
5. develop a forward looking view of potential ICT developments; and
6. discuss the impact of ICT on business model.
Module Overview
Today the number of businesses using computers, accessing the Internet and using web sites or home pages continues to grow. This is mainly due to personal computers (PCs), local and wide area networks (LAN / WAN), data storage devices, email, Internet, world wide web (www) and other ICT tools and systems making it possible for individuals and small businesses to (cost-efficiently) create, process, transmit and store information electronically.

In the construction industry there is increasing evidence of the integration of information and communication technology (ICT) applications into the industry’s business processes. Construction organisations are faced with many new challenges, including the need to change current work practices to become more competitive and more productive. The industry has to realise that investing in ICT is no longer primarily buying a piece of hardware or software. It is now more of a potential long term investment in the process of change itself.

Designed for: Owner/Managers, Administrators, Sole Trader, Partnerships, Small Company Structures
APPLICATION OF ICT IN CONSTRUCTION

Course Contents

1 Introduction ........................................................................................................................ 5
2 Computer Basics................................................................................................................ 5
  2.1 Difference between an operating system and an application ...................................... 6
  2.2 Microsoft Office ........................................................................................................... 6
  2.3 Word ............................................................................................................................ 6
  2.4 Excel ............................................................................................................................ 8
  2.5 The Internet ................................................................................................................ 9
  2.6 Difference between a web address and an email address ........................................... 10
  2.7 Email ......................................................................................................................... 10
    2.7.1 Advantages of Email .......................................................................................... 11
3 Pre contract Activities ...................................................................................................... 11
  3.1 Take off ..................................................................................................................... 12
  3.2 Build up unit rates ..................................................................................................... 12
  3.3 Duration estimation ................................................................................................... 12
  3.4 Databases – reviewing and storage ......................................................................... 12
  3.5 E-procurement .......................................................................................................... 12
4 Post Contract Activities .................................................................................................... 13
5 Other ICT technologies .................................................................................................... 13
  5.1 Building Information Modelling .............................................................................. 13
  5.2 Cloud computing ....................................................................................................... 13
  5.3 Video conferencing ................................................................................................... 14
    5.3.1 Equipment checklist ........................................................................................... 14
  5.4 Electronic contract communications ........................................................................ 14
6 Benefits of ICT applications ............................................................................................ 15
7 Constraints of ICT applications ....................................................................................... 15
8 Construction Computer software in use .......................................................................... 15
  8.1 Availability of construction software on the local market ......................................... 16
9 Appendices ....................................................................................................................... 17
  9.1 Appendix 1: Microsoft Excel – Quick reference .................................................... 17
1 INTRODUCTION

Construction projects involve a large number of direct stakeholders who are clients, professional design teams and construction companies and indirect stakeholders such as local authorities, the citizens, workers, customers and suppliers. All these have differing levels of understanding and interests in the project. Thus managing construction projects consists of planning, coordinating and controlling many work processes, that span different stages or phases involving many different participants, each often utilizing different information and communication exchange systems. This makes the construction industry one of the most information-intensive industries and requires close coordination among a large number of specialized but interdependent organizations and individuals to achieve the cost, time and quality goals of a construction project.

The industry is characterized by inaccurate and untimely communication that often results in costly delays to the progress of the project. Thus one of the most significant problems presently facing the construction industry is communication. ICT is seen by many as a potential solution to this problem. ICT can provide unifying modelling, management and communications systems to bring the unique talents of project participants together in a more productive and integrated manner. Despite advances in computing and IT, the construction industry is making insufficient use of transferring project data and information electronically. McCaffery et. al. (1991) argues that data exchange between project participants is still largely undertaken on paper. On the other hand, (Boyd and Paulson 1995) comments that leading consulting and construction firms are increasingly recognizing computers as a strategic technology and it is very probable that these firms will be the ones who will ensure the industry’s success in the future.

Software packages support an increasing number of functions within the business environment:
- **Budget / project management**;
- **Financial management / accounting**;
- **Payroll**;
- **Human resource management systems (leave, confirmation etc)**; and
- **Supply logistics inventory control (requisitions, invoice)**.

2 COMPUTER BASICS

A computer system can be divided into two components; the hardware; and the software.

**Hardware** is the physical parts of the computer system – the parts that you can touch and see e.g. a CPU, a keyboard and a monitor.

**Software** is a collection of instructions that can be ‘run’ on a computer. These instructions tell the computer what to do. Software is not a physical thing (but it can of course be stored on a physical medium such as a CD-ROM), it is just a bunch of codes.
Hardware is useless without software to run on it. Software is useless unless there is hardware to run it on.

2.1 DIFFERENCE BETWEEN AN OPERATING SYSTEM AND AN APPLICATION

An Operating System (OS) is the System Software that makes the Computer work. We can say that an OS is Software that acts as an interface between you and the hardware. It not only contains drivers used to speak the hardware's language, but also offers you a very specific graphical user interface (GUI) to control the computer. E.g windows 7, 8 for Windows or Linux or Mac OS

Application software is the software that you install onto your Operating System. It consists of the programs that actually let you do things with your computer. These Applications are written to run under the various Operating Systems. These include things like your word processing programs, spreadsheet, email clients, web browser, games, etc. Many programs, such as most of the Microsoft Office suite of programs, are written in both Mac and Windows versions, but you still have to have the right version for your OS.

2.2 MICROSOFT OFFICE

Microsoft Office (or Office) is a collection of software programs.

<table>
<thead>
<tr>
<th>Program</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word</td>
<td>Word-processing</td>
</tr>
<tr>
<td>Excel</td>
<td>Spreadsheet</td>
</tr>
<tr>
<td>Access</td>
<td>Database</td>
</tr>
<tr>
<td>PowerPoint</td>
<td>Presentation</td>
</tr>
<tr>
<td>Outlook</td>
<td>E-mail</td>
</tr>
<tr>
<td>Publisher</td>
<td>Desktop publishing</td>
</tr>
<tr>
<td>OneNote</td>
<td>Notes</td>
</tr>
</tbody>
</table>

In all Office programs, you open, save, and close files.

- *Opening a file means loading a file from a disk into the program window.*
- *Saving a file stores it on a disk.*
- *Closing a file removes it from the program window.*

To get specific help about topics relating to the program you are using, you use the Help window. You can search the Help system by browsing topics or using keywords.

2.3 WORD

Word processing is the use of computer software to enter and edit text.
You can easily create and edit documents, such as: minutes; letters; and reports with pictures and graphics.

**Exploring the Parts of the Word document**

You can view the document screen in Print Layout view, Full Screen Reading view, Web Layout view, Outline view, and Draft view. The key elements of the screen in Print Layout view are the Ribbon, Quick Access Toolbar, insertion point, status bar, view buttons, and Zoom slider.

When text is entered, the word wrap feature automatically wraps words to the next line if they will not fit on the current line.

When corrections or additions need to be made, you can place the insertion point anywhere within a document using the mouse or keyboard, and then delete text using Backspace and Delete.

When you save a document for the first time, the Save As dialog box opens. This is where you name your file and choose a location in which to save it. After you have saved a document the first time, you use the Save command to save your changes in the document or use the Save As command to save it with a different file name or to a new location. The file extension is .doc/x.

You can create new folders for storing documents in the Save As dialog box.

You can locate and open an existing document using the Open dialog box.

You can use the Zoom slider to magnify or reduce the size of your document on the screen.

Full Screen Reading view makes it easier to view the entire document on the screen by removing the Ribbon and status bar and displaying only the text, not the layout, of the document.

You can use the Orientation command to change the page orientation to portrait orientation or landscape orientation.
2.4 **Excel**

Excel is a spreadsheet program.

A spreadsheet is a grid of rows and columns in which you enter text, numbers, and the results of calculations.

In Excel, a computerized spreadsheet is called a worksheet. The file used to store worksheets is called a workbook.

Each workbook contains three worksheets by default. The worksheet displayed in the work area is the active worksheet.

Columns appear vertically and are identified by letters. Rows appear horizontally and are identified by numbers.

A cell is the intersection of a row and a column. Each cell is identified by a unique cell reference.

The cell in the worksheet in which you can type data is called the active cell.

The Name Box, or cell reference area, displays the cell reference of the active cell.

The Formula Bar displays a formula when a worksheet cell contains a calculated value.

A formula is an equation that calculates a new value from values currently in a worksheet.

**Exploring the Parts of the Workbook**

The primary purpose of a spreadsheet is to solve problems involving numbers. The advantage of using a computer spreadsheet is that you can complete complex and repetitious calculations quickly and accurately.

A worksheet consists of columns and rows that intersect to form cells. Each cell is identified by a cell reference, which combines the letter of the column and the number of the row.

The first time you save a workbook, the Save As dialog box opens so you can enter a descriptive name and select a save location. After that, you can use the Save command in Backstage view or the Save button on the Quick Access Toolbar to save the latest version of the workbook. The file extension is .xls/x.
You can change the active cell in the worksheet by clicking the cell with the pointer, pressing keys, or using the scroll bars. The Go To dialog box lets you quickly move the active cell anywhere in the worksheet.

A group of selected cells is called a range. A range is identified by the cells in the upper-left and lower-right corners of the range, separated by a colon. To select an adjacent range, drag the pointer across the rectangle of cells you want to include. To select a nonadjacent range, select the first adjacent range, hold down the Ctrl key, select each additional cell or range, and then release the Ctrl key.

Worksheet cells can contain text, numbers, and formulas. After you enter data or a formula in a cell, you can change the cell contents by editing, replacing, or deleting it.

You can search for specific characters in a worksheet. You can also replace data you have searched for with specific characters.

The zoom controls on the status bar enable you to enlarge or reduce the magnification of the worksheet in the worksheet window.

Before you print a worksheet, you should check the page preview to see how the printed pages will look.

When you finish your work session, you should save your final changes and close the workbook.

Excel can be used to:
- Prepare material schedules from BOQs;
- record Daily labour, material, plant, equipment (Labour & Equipment histogram, material stock);
- Prepare of monthly valuations;
- Cashflow forecast;

Demonstration on using built in templates to prepare invoices, planners, etc

Quick reference guides are shown in Appendix 1

2.5 THE INTERNET
The Internet is a vast network of computers that are located all over the world and linked to one another. Connecting to the Internet requires special hardware and software and an Internet service provider (ISP).

The World Wide Web (or Web) is a system of computers that share information by means of links on Web pages.

A Web page is a document specially formatted to be displayed on computers connected to the Internet.

The Web uses an address system. The name for a Web address is Uniform Resource Locator (URL).
To view Web pages, you need special software called a **Web browser** such as Internet Explorer, Firefox, Chrome, Opera.

To go to a specific Web page, you click the Address bar in your browser, type the URL, and then press Enter.

### 2.6 Difference Between a Web Address and an Email Address

**www.unza.zm**

**abc@unza.zm**

### 2.7 Email

Email (electronic mail) is a way to send and receive digital messages across the Internet.

<table>
<thead>
<tr>
<th>Postal Mail</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td><a href="mailto:abc@unza.zm">abc@unza.zm</a></td>
</tr>
<tr>
<td>Unza</td>
<td></td>
</tr>
<tr>
<td>P.O. Box 32379</td>
<td></td>
</tr>
<tr>
<td>Lusaka</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delivery</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Your envelop or package is delivered by a mail carrier/bus</td>
<td>Your digital message is delivered electronically across the internet through various servers.</td>
</tr>
<tr>
<td>Received in a home mailbox or post office box</td>
<td>Received online in the Inbox of your email service provider (Gmail, Yahoo, Hotmail etc.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Average of 2 days for letters</td>
<td>Instantly or within a few minutes if servers are busy</td>
</tr>
<tr>
<td>Average of 3-10 days for packages</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contents</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>May include packets with documents or packages with larger items</td>
<td>May include attachments for digital documents, files, images, video and more</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costs</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The price of stamps or shipping for larger items</td>
<td>Free with internet connection</td>
</tr>
</tbody>
</table>

To receive emails, you will need an email account and an email address. Also, if you want to send emails to other people, you will need to obtain their email addresses. It's important to learn how to write email addresses correctly, because if you do not enter them exactly right your emails will not be delivered or might be delivered to the wrong person.

Email addresses are always written in a standard format that includes a username, the @ (at) symbol, and the email provider's domain. The username is the name you choose to identify yourself, and the email provider is the website that hosts your email account.

Today it's increasingly common to use a free web-based email service, also known as webmail. Anyone can use these services, no matter who provides their Internet access.

The top three webmail providers are Yahoo!, Microsoft's Outlook.com (previously Hotmail), and Google's Gmail. These providers are popular because they allow you to access your
email account from anywhere with an Internet connection. You can also access webmail on your mobile device.

You can also have an email address hosted by your organization. These email addresses are usually for professional / business purposes. For example, the people who work for this website have email addresses that end with @smecontractor.org. If you are part of an organization that hosts your email, they'll show you how to access it.

Many hosted web domains end with a suffix other than .com. Depending on the organization, your provider's domain might end with a suffix like .gov (for government websites), .edu (for schools), .mil (for military branches), .org (for nonprofit organizations) .zm (for Zambia), or .co.za (for South Africa).

**Information management (email) software**

Many companies and organizations use an information management application, like Microsoft Outlook, for communicating and managing their email. This software can be used with any email provider, but is most commonly used by organizations that host their own email.

### 2.7.1 Advantages of Email

- **Productivity Tools**
  
  Email is usually packaged with a calendar, address book, instant messaging and more for convenience and productivity.

- **Access to Web Services**
  
  If you want to sign up for accounts like Facebook, or order products from services like Amazon, you will need an email address so you can be safely identified and contacted.

- **Easy Mail Management**
  
  Mail service providers have tools that allow you to file, label, prioritize and filter your emails for easy management. You can even easily control spam or junk email.

- **Communicate with Multiple People**
  
  You can send an email to multiple people at once allowing you the option of having a conversation with several people or sending out a message to a hundred.

- **Private**
  
  Your email is delivered to your own personal and private account with a password required for accessing and viewing emails.

- **Access Anywhere at Anytime**
  
  You don’t have to be at home or office to get your email. You can access it from any computer or mobile device with Internet connection.

### 3 PRE CONTRACT ACTIVITIES

What tendering tasks can be done electronically? To use any software effectively, the user has to understand the manual process the software is emulating.
3.1 TAKE OFF
Quantity Takeoff building cost estimating software helps make material costing faster, easier, and more accurate. One is able to take off quantities from PDF, JPG or vector drawings. A contractor can verify BOQ quantities estimated by the consultant.

Demo of CostX software

3.2 BUILD UP UNIT RATES
Most computer aided estimating systems operate in a similar manner allowing the Estimator to accept the published rates or amend them to reflect the true cost of resources as obtained from quotations received for plant, labour and materials and combine these with their calculations and requirements for overheads and profit. The units rates may further be amended by the Estimator to take into account individual factors and constraints affecting the unit rate and hence the Estimators’ cost price.

Most software used is customized because a lot of factors affect the rates. Some contractors regard this as a trade secret and do not divulge this information.

3.3 DURATION ESTIMATION
For any project a contractor has to prepare a work program. The most popular software is Microsoft projects.

Demo of MS Project software

3.4 DATABASES – REVIEWING AND STORAGE
Microsoft Access can be customised to store databases.

Demo of Microsoft Access

3.5 E-PROCUREMENT
E-Procurement means to conduct procurement electronically. This involves, publishing contract notices online (e-notification), publishing all documents for a call for tenders online (e-access to tender documents), suppliers submitting offers to public buyers/contracting authorities electronically (e-submission) etc. SMEs have to be familiar with where they can access eTender notices such as dgMarket. Locally see client websites. Organisations like the EU indicate that by September 2018, electronic submission of offers (e-submission) will become mandatory for all contracting authorities.

E-Tendering is becoming increasingly popular as it allows contractors to extend the use of electronic communication and data exchange to sub-contractors and suppliers who have the facility to deal with information exchanged in this manner. Most large organisations now possess and use this technology but smaller sub-contractors operating in a limited discipline could be excluded by this process and hence the competition for a contract be reduced. The rapid exchange of information enables a speedier tendering process and allows rates quoted by suppliers and sub-contractors to be incorporated into the unit rates and estimate accurately.

Using E-Tendering, contractors can:

- Receive notification of the relevant tenders;
- Purchase tenders document;
- Submit Bids Online; and
- Track the status of their bids.
The client has to put this in place. Not aware of client organisations that have software in place to accept and evaluate bids electronically.

4 POST CONTRACT ACTIVITIES
What tasks during construction (post award) can be done electronically
a) Preparation of material schedules from BOQs
b) Daily labour, material, plant, equipment recording (Labour & Equipment histogram, material stock)
c) Preparation of monthly valuations
d) Cashflow forecast

Demo of Microsoft Excel customisation to carry out these tasks

5 OTHER ICT TECHNOLOGIES

5.1 BUILDING INFORMATION MODELLING
As technology continues to evolve, some traditional locations of facility information are changing. Building information modelling (BIM) is a process involving the generation and management of digital representations of physical and functional characteristics of places. Building information models (BIMs) are files which can be exchanged or networked to support decision-making about a place. Building Information Modeling (BIM) uses computer programs to document facility design, to simulate construction, and to simulate facility operation. A BIM database can be an intelligence-rich model that allows extraction of graphical and data information. BIM is beginning to incorporate some traditional specification and product-specific information into the model.

BIM allows design and construction team members to collaboratively embed intelligence into the model in order for personnel to concentrate on design and problem-solving tasks while allowing the computer to perform tasks such as quantity take-offs for cost estimating or product ordering, clash detection, scheduling, and quality assurance.

Perhaps the greatest advantage of BIM is visualization of the target costs alongside multiple design options enabling target cost driven design. Another advantage is how easily past project data can be brought into the estimate. Even an early massing or conceptual model can add an advanced level of detail to your work which can also provide early and accurate scheduling. You can then validate those assumptions as the design develops.

5.2 CLOUD COMPUTING
Cloud computing is simply the act of utilizing a network, usually the Internet, to store information that you want to access from multiple network devices. By utilizing “The Cloud,” you can get to any of your uploaded information anywhere you have access to the Internet. The tutorials below can help you make the most of using the cloud.

Cloud computing is typically defined as a type of computing that relies on sharing computing resources rather than having local servers or personal devices to handle applications. In cloud computing, the word cloud (also phrased as "the cloud") is used as a metaphor for "the
Internet,” so the phrase cloud computing means ”a type of Internet-based computing,” where different services — such as servers, storage and applications — are delivered to an organization's computers and devices through the Internet.

Examples of cloud computing include Gmail, yahoo, Hotmail

5.3 VIDEO CONFERENCING
Videoconferencing (or video conference) means to conduct a conference between two or more participants at different sites by using computer networks to transmit audio and video data.

Skype is a telecommunications application software that specializes in providing video chat and voice calls from computers, tablets and mobile devices via the Internet to other devices or telephones/smartphones. All of this is possible through a technology called voiceover IP, or VoIP (pronounced voyp). VoIP is a method of transmitting the human voice over Internet protocol (IP) networks. Skype uses VoIP to let you make phone calls, video calls, group calls, and more over the Internet instead of using traditional phone lines.

A key difference is simply what each solution is designed for. Skype is optimized for point-to-point audio and video calls, which means it is designed to support two computers and two participants. On the other hand, video conferencing is optimized for multi-point calls, which means multiple parties on multiple devices can participate in a single call.

5.3.1 Equipment checklist
A high-speed Internet connection: This can be DSL, satellite, or a cable modem. A dial-up connection is OK for instant messaging on Skype, but it isn't enough for voice or video calls.

Speakers and a microphone (built into your computer or separate): Some people like to use headphones or even a full headset so they can hear and talk to the other person more clearly.

Using a headset to talk on Skype.

A webcam if you want to make video calls: Many new computers even come with built-in webcams. If your computer doesn't have one, you can buy one in stores.

5.4 ELECTRONIC CONTRACT COMMUNICATIONS
Much of today’s business is conducted via e-mail, and it’s possible to bind yourself to a contract through e-mail, either deliberately or inadvertently.

If an e-mail or chain of e-mails clearly states an offer for entering into a deal with all of the material terms and the other side responds by e-mail accepting the terms, then there’s a good chance that a valid contract has been formed — even though no signatures have been exchanged. So be careful. If all you intend is to negotiate the issues leading to a formal written and signed contract accepted by both parties, make sure you say that in your e-mails.

Today digital signatures are being used and accepted by different business organisations.

Contracts which expressly permit the giving of notices by email typically deem the notice to have been received at the time shown on a “delivery receipt” received by the sender. Ensure that it is clear that it is not:

\[
a) \text{the time the email is sent by the sender; or} \\
b) \text{a specific period after the time it is sent by the sender.}
\]
In Zambia there are currently no contracts that accept electronic submissions of tenders. However, the Zambia Public Procurement Authority intends to go electronic. *Electronic – Government Procurement* (E-GP) is the use of Information & Communications Technology (especially the Internet) by governments in conducting their procurement relationships with suppliers for the acquisition of goods, works and consultancy services required by the public sector. It is not clear when the E-GP will be effected.

ALWAYS CHECK THE BID DOCUMENT TO ENSURE THAT ELECTRONIC SUBMISSIONS ARE ACCEPTABLE.

### 6 BENEFITS OF ICT APPLICATIONS
- Reduces mistakes in documents
- Ease of doing complex tasks
- Time saving
- Increased productivity
- Reduces degree of difficulty
- Increases speed of work
- Increases document quality
- Reduces proportion of new work
- Reduces construction errors

### 7 CONSTRAINTS OF ICT APPLICATIONS
- High cost of investment
- System and computer malfunction and virus attacks
- Poor security and privacy
- Continual need to upgrade
- High cost of professionals to employ
- Incompatibility in software packages
- Personal abuse
- ICT making professionals redundant
- Inadequate power supply

### 8 CONSTRUCTION COMPUTER SOFTWARE IN USE

a) General
   - MS word
   - MS Excel
   - Presentation software
   - MS PowerPoint
   - MS Outlook
   - Adobe Pagemaker

b) Architectural/Engineering Design and Drawing software
   - CorelDraw
c) Quantity Surveying Measurement and Estimating
   - CostX
   - WinQS
   - CataPro
   - MasterBill
   - QS Elite
   - Snape Vector

d) Project Planning and management software
   - MS Project
   - Pathmaker
   - Cleopatra

8.1 AVAILABILITY OF CONSTRUCTION SOFTWARE ON THE LOCAL MARKET
   - AutoCad, Candy, Win QS, CostX,
   - (local – L.T & Associates)
   - Subcontract (specialist software e.g. Rebar)
   - Bar coding (inventory tracking)
   - Microsoft Projects, Microsoft Office (Excel)
9 APPENDICES

9.1 APPENDIX 1: MICROSOFT EXCEL – QUICK REFERENCE

Microsoft Excel for Windows
Buttons may vary visually from version to version

Toolbars and Buttons

The Standard and Formatting toolbars are shown below. To activate the toolbar choose Toolbars from the View menu. Other toolbars can be displayed by pointing at the toolbar and clicking the right mouse button. Point at any button for a short description of its function.

Online Help

Extensive online help is available. Use the Help menu or click on the Office Assistant (Help) button on the toolbar.

Work in Cells and Ranges

Select a cell or range of cells, type numbers or values or perform an action on existing data.

- Enter data
  ⇒ Select a cell, type an entry, then press ENTER
- Select a range of cells
  ⇒ Click in the first cell of the range, hold the mouse button and drag
- Select an entire row or column
  ⇒ Click the row number or the column letter
- Canceling entries
  ⇒ Press ESC or use the Undo feature

Enter Data Automatically

Enter the same data in several cells, enter an incremental series, or automatically calculate a sequence of formulas.

- Enter the first value or formula then drag the fill handle
- For a numerical, incremental series, hold the CTRL key while dragging the fill handle
- For a sequence of formulas, enter the first formula, then drag the fill handle; the formulas are calculated based on the relative cell reference if a cell reference is used in the first formula
Modify the Data

• To edit the contents of a cell, double-click the cell, then make the changes
• Move a cell or range of cells by pointing to the border and dragging to a new location
• To copy instead of move, hold the CTRL key while dragging
• To clear cell entries, select the cell, then press the DELETE key
• The Cut, Copy, and Paste buttons on the toolbar work as in all Windows applications

Formulas

• Select the cell where the result will appear, then type the equal sign (=)
• Enter numbers, cell references, or functions (formulas built into Excel)
• Use the AutoSum button [Σ] to sum rows or columns; if the range that Excel suggests for the sum is incorrect, drag to indicate the correct range, then press ENTER

Change the Appearance of Text and Data

• Use the Formatting toolbar for Bold, Italic, Underline, and alignment in cells
• Use AutoFormat (Format menu) to select from built-in formatting options
• If ####### appears in a cell, widen the column by dragging the column border (pointer appears as a two-headed arrow)

Sheet Layout

• Excel workbooks can contain multiple sheets; use the sheet tabs at the bottom of the screen
• Page setup (margins, page breaks, headers and footers, etc.) work as in all Windows applications; use Page Setup (File menu) to change the page setup

Save, Preview, and Print

• First time, or to change name, drive, or directory: choose Save As from the File menu
• Enter a document name
• Choose a drive and directory
• Next time: choose Save from the File menu or use the Save button on the toolbar
• To preview your document: Choose Print Preview from the File menu or use the Preview button on the toolbar
• To print your document: Choose Print from the File menu or use the Print button on the toolbar
• You can select and configure printers after choosing Print from the File menu

Excel Menus

File
Open
Open existing documents or import delimited text files

Page Setup
Page tab
Orientation; Scaling (by percentage or “fit to” number of pages)

Margins tab
Center on page (Horizontally and/or Vertically)

Header/Footer tab
Select header/footer elements from lists or design custom header/footer

Sheet tab
Print Titles (row or column to repeat on each page)
Gridlines (applies to printed copy)
Page Order (for multiple page spreadsheets)
Copying and Moving Formulas: Relative vs. Absolute Cell References

In order to be certain that the copied formula is giving you the information you want, it is absolutely necessary to understand the differences between absolute and relative cell references. First, let's work an illustrating example. Enter a formula in cell J15 that references the cells C15, E15, and G15, and adds their contents. When you are satisfied that the formula is correct, press enter. Now copy the formula in cell J15 into cells J16 and J17.
Next, look at the formulas in each cell. Even though they were copied from the same cell, all three formulas are different. Each formula refers to the cells that are three, five, and seven cells to left of cells J15, J16, and J17 respectively. A person thinks “Add the contents of cells C15, E15, and G15 and place the result in J15.” Excel thinks “In this cell, display the result of adding the contents of the cells that are three, five, and seven cells to the left.” Excel changes the cell references to match the position of each cell relative to the cell into which Excel copies the formula.

Copying preserves relative cell relationships

On the other hand, when you move a cell containing a formula, or a group of cells containing formulas, the relative relationships are not preserved. The cells references are copied absolutely.

Moving preserves absolute cell references

Things to note:

- Always select the cell or cells that you want to copy or move first.
- You can copy from a single cell to a multiple cell destination.

Relative, Absolute, and Mixed Cell References

From time to time, you will want to make certain that Excel treats a reference to a cell as absolute, no matter what. The way Excel knows that a cell is to be referenced absolutely is by the use of the dollar sign $. If you enter a cell reference as A5, this will be interpreted by Excel as a relative cell reference. Alternatively, if you enter the reference as $A$5, Excel
will treat this reference as absolute. Absolute references can be entered manually from the keyboard, or by pressing the F4 key, you can cycle through the various reference types.

**Mixed Cell References:** These are a blend of absolute and relative references. Mixed cell references look like $A1 or A$1. Their primary purpose is to ‘freeze’ either the column or row respectively, while still allowing the counterpart to vary as the formula is copied either vertically or horizontally.

**Referencing other Worksheets**

You can also reference other worksheets in a formula by specifying the worksheet name. For example:

```excel
=sheet2:A5+Sheet4:B7
```

This will add cell A5 on sheet 1 to cell B7 on sheet 4 and put the results wherever you have typed the formula. Relative and absolute still apply. When copied the sheet name will change relative to the copy location if you copy the formula from one sheet to another.

**Referencing Other Files**

You can also reference other files in a formula by specifying the file name. For example:

```excel
```

This will add cell A5 on sheet 1 in the spreadsheet myfile.xls to cell B7 in myotherfile.xls on sheet 4 and put the results wherever you have typed the formula.